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• A spreadsheet software can also store, manipulate and create graphical 
representations of data.

• LibreOffice Calc is used to perform the following activities accurately and 
efficiently.

• Tabulation of data
• Simple mathematical calculations
• Complex calculations using formula and functions
• Arranging data in ascending and descending order (sorting)
• Filtering the required data
• Check the validity of data
• Protection of data using passwords
• Saving for future use
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• (a) Title bar: The Title bar, located at the top, shows the name of the current spreadsheet. When the spreadsheet is newly
created, its name is Untitled X, where X is a number. The first created spreadsheet takes the name as Untitled 1, second is
Untitled 2 and so on.

• (b) Menu bar: Menu bar is located just below the Title bar. It contains the menus with commands for various tasks. Each
menu item has a submenu called pull-down menu. The various menu items are briefly explained below.

• (i) File: contains commands applied to entire document — Open, Save, Wizards, Export as PDF, Print, Digital Signatures
and so on.

• (ii) Edit: contains editing commands — Undo, Cut,Copy, Paste, Select, Find & Replace and so on.

• (iii) View: contains commands for modifying the user interface — Toolbars, Column & Row Headers, Full Screen, Zoom and
so on.

• (iv) Insert: contains commands for inserting elements into a spreadsheet — Image, Media, Chart, Object, Shapes, Date,
Time, Headers and Footers.

• (v) Format: contains commands for modifying the layout of a spreadsheet — Cells, Rows, Columns, Page, Styles and
Formatting, Alignment and so on.

• (vi) Styles: for managing styles.

• (vii) Sheet: contains commands to insert and delete cell, rows and columns, insert sheet, rename sheet, fill cell, etc.

• (viii) Data: contains commands for manipulating data — Define range, sort, and so on.

• (ix) Tools: contains various functions to check and customise spreadsheet — Spelling, Language, Gallery, Macros and so on.

• (x) Window: contains commands window — New Window, Split and so on.

• (xi) Help: contains links to the help system included in the software and other miscellaneous functions — Help, License
Information, Check for Updates and so on.
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• Toolbars: The Calc opens with the Standard and Formatting toolbars at the top of the workspace by default. These
toolbar provide a wide range of common commands and functions. Placing the mouse cursor over any icon displays a
small box called a tooltip. It gives a brief explanation of the icon function.

• (i) Standard toolbar: The standard tool bar shows the icons for most common operations, such as editing, arranging,
filtering, etc., used while working on the spreadsheet.

• (ii) Formatting toolbar: Formatting toolbar has the most common operation related to formatting datasheet. It
includes buttons for font selection, size of text, alignment, cell value formatting and indentation, etc.

• (iii) Formula toolbar: It allows entering and editing the formula in the cell. Formula bar consists of the following:

• Name box: shows the cell reference, for example A1.

• Functions wizard: search the function from the list of available functions.

• Sum: used to total the numbers in the cells above the selected cell. The sum is placed in the selected cell.

• Function: clicking on the Function icon inserts an equals (=) sign into the selected cell and the Input line allow formula 
to be entered. 

• • Input line: displays the contents of the selected cell (data, formula, or function) and allows editing the cell contents. 
To edit inside the Input line area, click in the area, then type the changes. To edit within the current cell, just double-
click in the cell. 

• Worksheet: The worksheet in Calc is also referred to as spreadsheet. The spreadsheet can have many sheets. Each 
sheet can have many individual cells  arranged in rows and  columns. The sheet tab shows its default name as Sheet1, 
Sheet2, Sheet3, ….
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• e) Rows and columns: Each sheet can have a maximum of 1,048,576 (220) rows and 1024
(210) columns. The rows are numbered as 1,2,3,4,… and columns are numbered as A, B, C, D,
…., Z, AA, AB,AC, …., AZ, BA to BZ, CA,…., AMJ.

• (f) Cell and cell address: The intersection of a row and column is called a cell. It is the basic
element of a spreadsheet. It holds data, such as text, numbers, formulas and so on. A cell
address is denoted by its column (letter) and row number. For example, D4, E9, Z89

• (i) Active cell: When we position the mouse cursor on a cell, it gets selected, and is ready to
take data from the user. This selected or activated cell is called as ctive cell. It is always
highlighted, with a thick border. The address of the active cell is displayed in the name box.

Excercise 1

• Write the cell address of the following

1. Seventh column and tenth row …….

2. Tenth column and nineteenth row ……..

3. The cell address LK89 is situated in

row number……. and column letter …..

(ii) Range of cells: A block of adjacent cells in a

worksheet which is highlighted or selected

is called a range of cells. 
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• The column range is the number of cells spread across the 
column.example C2:C7

• The row range is the number of cells spread across the row.example B3:D3

• The row and column range is the number of cells spread across the row 
and columns. Example B2:C7

• The control key is used to select more than one ‘range of cells’ in a 
worksheet.
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Entering data
• The data to be entered can be the label, values or formula.

• (a) Label: Label is the any text entered by using a keyboard. It may combine 
with letters, numbers, and special symbols.

• Excercise2:
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• (b) Values: The numerical data  consisting of only numbers are called 
values. By default values are right aligned. There are various forms of 
values, such as integer, decimal and so on.

• (c) Formulae: Any expressions that begins with an equals ‘=’ is treated as 
formula. In the expression, the ‘=’ followed by values, cell address and 
functions are called as formula.
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Mathematical operators used in formulae:

Exercise 3:
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Formulae with cell addresses and operators:

Exercise 4: create a simple spreadsheet to prepare  a shopping bill of 
stationary of the following items.

The results obtained from a formula (based on cell addresses) always 
get updated automatically when the values of these cells mentioned in 
the formula change.
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Use of functions to do calculations:
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• Exercise 5:The Figure shows marks scored by students in three different subjects.

• 1. Write the formula in E2 to find the total marks scored by HARMAN.

• 2. Copy the formula entered in E2 for other students.

• 3. Write the formula in F2 to find the average marks scored by HARMAN?

• 4. Copy the formula entered in F2 for other students.

• 5. Write the formula in cell B7 to find the highest score in Hindi.

• 6. How will you find the highest score in English and Maths?

• 7. Write the formula in cell B8 to find the total number of students who appeared in Hindi?

• 8. Write the formula in cell B9 to find the lowest score in Hindi.

• 9. How will you find the lowest score in English and Maths?

• 10. How will you find the highest score in Hindi, English and Maths?
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Formatting the worksheet
The Format cells dialog box can be opened using Format→cells using the Format menu, or from context menu 
opened through right clicking the cell. Format Cell dialog box can be opened by pressing the shortcut key Ctrl+1
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Formatting a range of cells with decimal places
Following are the steps to format a cell to the required number of decimal places:
• Select the range of cells.
• Open the ‘format cells dialog’ box
• Click the ‘Number’ tab
• Select the ‘Number’
• Change the decimal places as required

Formatting a range of cells to be seen as labels
• while entering the telephone number with the STD code the first digit zero (‘0’), disappears from the telephone number. This is 

because the telephone number is stored as a numeric value, and the numeric value does not have a preceding zero. If you make these 
numeric values as text, then the complete telephone number will appear with a preceding zero.

• Select the range of cells
• Open the ‘format cells dialog’ box
• Click the Number tab
• Select Text
• Click ‘OK’
• Enter numbers
Formatting of a cell range as scientific

• In a spreadsheet, by default the date format is in American Format; (mm/dd/yyyy) (mm-month, dd-date, yyyy-year). The date 
12/09/2018 means that it is the 09th day of December 2018. In a spreadsheet application, the user can change this Date in many 
different formats (Figure 4.26). To do these follow the below steps.

• Select the range of cells.
• Open the ‘Format cells dialog’ box
• Click the ‘Number’ tab
• Select the ‘Date’ category
• Select the date format
• Click ‘OK’ AJ



Formatting a range of cells to display times

• Time is indicated in a computer as 10:35:53 AM. The common format of this is  hh:mm:ss AM/PM (Figure 4.27). Here, hh means 
hours, mm means minutes and ss means second. Follow the steps below to format a range of cells to display the time.

• Select the cell range
• Open the ‘format cells dialog’ box
• Click the ‘Number’ tab
• Select the ‘Time’ category
• Select category Time should be displayed
• Click ‘Ok’

Formatting alignment of a cell range

• The labels and values can be aligned to the left, center or right of a cell range by using the alignment icons 

• (Left, Right, Center) on the standard toolbar.
• Select the range of cells
• Open the ‘format cells dialog’ box
• Click the ‘Alignment’ tab
• Select left, right or center
• Click ‘OK’
Exercise 6 :Create the worksheet as shown in Figure using formatting tools and formulae. 
• Center align row 1.
• Make row 1 and row 2 Bold.
• Italicise cells A3, A4, A5.
• Use function AVERAGE in cell E3 to calculate the average of Hindi (B3) English (C3) and Maths (D3).
• Copy this formula by dragging it from E3 to E6.
• Use function AVERAGE and write a formula in B7 to calculate the average of Class 9 (B3), Class 10 (B4), Class 11 (B5), Class 12 (B6) for 
the subject Hindi.
• Copy this formula by dragging it from B7 to D7 and use them to calculate the average for English and Maths.AJ



Speeding up data entry
• The most important ability of a spreadsheet is to drag and drop the contents of one cell 

to another by using a mouse.

• Using the fill handle: The Calc Fill Handle tool is used to fill the next cells till you drag it 
with the next predefined value.

• Fill handle of a cell: The small black square in the bottom-right corner of the selected cell 
or range is called a fill handle

Uses: 

• a) For number series: Type the numbers 1, 2 in two consecutive cells and select them 
using a mouse. Click on the right down corner of the selected cells, hold down the first 
button of mouse and drag  downward till you want to continue

• b) Copying a formula: If you wish to apply the same formula to the number of cells in the 
rows or columns, a formula can be copied. 

Use of copy and paste commands for copying formulae

Uses of fill handle for copying formulae
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• Exercise 7 Create the worksheet as shown in Figure 
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Referencing
• Referencing is the way to refer the formula or function from one cell to the next cell along the row or column.

• There are three types of referencing.

a) Relative referencing

b) Mixed referencing

c) Absolute referencing

(a) Relative Referencing: When you drag any formula in any row or column in any direction, the formula gets copied in 
the new cell with the relative reference. Almost all spreadsheet applications use relative referencing by default.

(b) Mixed referencing: As we have seen, when we drag the formula, row number or column name get change in relative 
reference. In Mixed Referencing, the $ sign is used before row number or column name to make it constant. In mixed 
referencing one cell address name is variable and one cell address is constant. 

(c) Absolute referencing: In Absolute referencing, a $ symbol is used before the column name as well as row number to 
make it constant. For example, $C$12, $D$5, etc. In this case, even if you drag your formula in any direction, the cell 
name remains constant. This type of referencing is used in higher classes.
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Creation of Charts Using Spreadsheets
Let us use the worksheet below to create a column
chart.
• Follow the steps given below to create charts.
• Select the range of data (A1:F7)
• Insert → Chart
• Select the type of chart
• Select the chart (Column Chart)
• Click finish.

Exercise 8:Quadratic function chart of the equation 
Y= 𝑋2-5X-3 is given in the Figure.
1. Enter the values 2 to 7 in axis as shown in worksheets.
2. Enter the formula below in cell B2. = B1^2-5*B1-3
3. Copy the formula entered in B2 upto K2
4. Mark A1:A2 a data range
5. Insert → Chart → XY Scatter
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Home Work
• Collect the electricity bill of your home for

each month from January to December (12
months). Create a worksheet with the data
of Name of the Month and Bill Amount as
below. Enter the data in a worksheet and
develop the chart of various types.
Conclude your result that which type of
chart will be more appropriate for such
type of data.
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